National NHS Staff Survey

Guidance Notes
National NHS Staff Survey Guidance Notes

Table of Contents

Introduction 3

Part One - Introduction to the New National Survey 4
1.1. Background to the survey 4
1.2. Summary of minimum survey requirements 4
1.3. Timetable for the survey 5
1.4. Immediate preparation for the October survey 5

Part Two: Step by step instructions for the National Staff Survey 7
2.1. Key survey contact within the trust 8
2.2. Approved Contractors 8
2.3. The questionnaire 9
2.4. Preparation of staff lists 11
2.5. Selecting the Staff Sample 13
2.6. Pre-survey communication with staff 18
2.7. Other ways of boosting response rates 19
2.8. Printing of questionnaires, covering letters and reminder cards/letters 20
2.9. Distribution and receipt of questionnaires, and prompting non-respondents 21
2.10. Data entry and data transfer to the Advice Centre 23
2.11. Reports of the survey findings 27
2.12. Ethical considerations 27

Appendix 1: Text of covering letter with questionnaire 28
Appendix 2: Text of first reminder 29
Appendix 3: Text of second reminder 30
Appendix 4: Summary of information to be transferred to the Advice Centre 31
Appendix 5: Detail of how to perform some procedures in Excel 32
Appendix 6: Development of the survey 33
Appendix 7: Contact details of Approved Contractors 34
National NHS Staff Survey Guidance Notes

Introduction

The main purpose of these Guidance Notes is to guide trusts, PCTs and Survey Contractors through the practical steps of conducting the National Staff Survey. The guidance notes are separated into two main sections.

Part One - *Introduction to the New National Survey*

1.1. Background to the survey
1.2. Summary of minimum survey requirements
1.3. Timetable for the survey
1.4. Immediate preparation for the October survey

Part Two: *Step by step instructions for the National Staff Survey*

2.1. Key survey contact within the trust
2.2. Approved Contractors
2.3. The questionnaire
2.4. Preparation of staff lists
2.5. Selecting the Staff Sample
2.6. Pre-survey communication with staff
2.7. Other ways of boosting response rates
2.8. Printing of questionnaires, covering letters and reminder cards/letters
2.9. Distribution and receipt of questionnaires, and prompting non-respondents
2.10. Data entry and data transfer to the Advice Centre
2.11. Reports of the survey findings
2.12. Ethical considerations

The appendices contain templates of the letter to accompany the questionnaire, the first reminder postcard and the second reminder letter, as well as details of information and documents to be transferred to the Advice Centre, and an account of the questionnaire development and piloting of the survey.

An Advice Centre web site and advice line is now available for the National Survey.

- Web site: www.nhsstaffsurveys.com
- Advice Line: 0121 359 2491 (10am-4pm Monday to Friday).
- E-mail: Carol Hopkins (C.M.Hopkins@aston.ac.uk) or Glenys Foskett (G.M.Foskett@aston.ac.uk)

Researchers from the Advice Centre will provide practical support and advice to the trusts as they conduct the survey.
PART ONE : INTRODUCTION TO THE NEW NATIONAL SURVEY

1.1. Background to the new survey
The Commission for Health Improvement, in conjunction with the Department of Health, appointed Aston University to develop and pilot a new national NHS staff survey, and to establish an Advice Centre and web site to support that process.

All three organisations have worked in partnership to consult widely with NHS staff about the content of the new national survey. The work has been conducted under the guidance of a stakeholder group, which has representatives from Staff Side, CHI, DH, HR Directors, Strategic Health Authorities and the NHS workforce. (Further information about the development and piloting of the new survey can be found in Appendix 6).

The purpose of this new annual survey is to collect staff views about working in their local NHS trust. The intention is that it will replace the need for trusts to carry out numerous staff surveys. The new survey has been designed to replace trusts’ own annual staff surveys, the Department of Health 10 core questions, and the CHI Clinical Governance Review staff surveys. It is intended that this one new annual survey will cover the needs of CHI, DH and trusts. Thus, it will provide information both for deriving national performance measures (including star ratings) and for helping the NHS, at both a national and local level, work towards Improving Working Lives. The design also incorporates questions relating to the Positively Diverse Programme. Trusts will be able to use the findings to identify how their policies are working in practice.

This survey will enable organisations, for the first time, to benchmark themselves against other similar NHS organisations and the NHS as a whole, on a range of measures of staff satisfaction and opinion.

1.2. Summary of minimum survey requirements
It is obligatory for all NHS trusts and PCTs in England to implement this new survey with a sample of their staff at the end of October 2003. (Strategic Health Authorities, Workforce Development Confederations and other NHS employers are also strongly encouraged to conduct the survey, although it is not currently compulsory to do so).

All trusts and PCTs must follow a standard methodology, as described in detail later in these guidance notes, and must fulfil the following minimum requirements:-

- A self-completion survey with a random sample of staff
  (see section 2.5 for more details on sampling)

- The questionnaire must contain the full set of Core questions
  (see section 2.3 for more details on the questionnaire)

- A staff survey communication strategy must be implemented
  (see section 2.6 for more details on internal communication)

- Questionnaires (each labelled with a unique staff ID number) to be distributed to selected staff via trusts' internal post, with at least two reminders being sent to non-responding staff (2nd reminder to be accompanied by a 2nd copy of the questionnaire)
(see section 2.9 for questionnaire distribution procedures)

- Provision of survey data (in a prescribed format) to the Advice Centre (see section 2.10 for data entry and formatting procedures)

There are a number of additional ways in which trusts can adapt the survey to their local needs:

- trusts may conduct a survey with a larger staff sample or census
- trusts may select additional questions from an Optional Question Bank
- trusts may include a limited number of their own Local questions on other topical issues

More detail about all these survey elements can be found later in sections 2.3, 2.4 and 2.5.

1.3. Timetable for the new survey
The National Survey is scheduled to launch in the week commencing 27\textsuperscript{th} October 2003, with both national results and trust level results available in February/March 2004. Trusts are, however, able to commission reports based on their own data from their contractors, which can be developed prior to the reports they receive from the Advice Centre.

In the week commencing 27\textsuperscript{th} October, all trusts should distribute the questionnaires to a sample of their staff. (Trusts may choose to distribute the questionnaire earlier if they would prefer to attach questionnaires to pay slips. However, trusts should not distribute the questionnaires later than the week commencing the 27\textsuperscript{th} October).

Trusts are advised to notify staff that although the launch week coincides with half term school holidays for some regions, there will be plenty of time for absent staff to complete their questionnaires when they return to work in November.

Two weeks after the initial mailing (w/c 10\textsuperscript{th} November if initial mailing was w/c 27\textsuperscript{th} October), trusts should distribute a first reminder postcard to all staff who have not yet returned a questionnaire.

A second reminder letter, together with an extra copy of the questionnaire, should be distributed to non-responding staff a further two weeks later (w/c 24\textsuperscript{th} November, if the initial mailing was in w/c 27\textsuperscript{th} October).

The final date for transfer of the survey data to the Advice Centre is the 19th of December 2003.

1.4. Immediate preparation for the October survey
There are a number of key tasks that should be started as soon as possible, to help ensure that organisations are ready to conduct the survey:

- updating of the trust / PCT staff database, including accuracy of work address information, in preparation for selecting the staff sample (see sections 2.4, 2.5)
- making contact with the Advice Centre, to let them know which member of staff will be responsible for the survey implementation (please see section 2.1)
• making contact with an approved survey contractor, who will be able to help the trust / PCT with the preparation for and implementation of the survey (see section 2.2)

Please see page 3 for contact details of the Advice Centre.
PART TWO: STEP BY STEP INSTRUCTIONS

The following step-by-step instructions are designed to guide trusts, PCTs and Survey Contractors through the survey procedures.

An Advice Centre, based at Aston University, has been set up to support the whole process. You will have access to the Advice Centre throughout the National Staff Survey period. See page 3 of these Notes for information on how to contact the Advice Centre.

In summary, the basic steps are:

<table>
<thead>
<tr>
<th>Step of Survey Implementation</th>
<th>Section in Guidance Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Identify an individual within the trust who will take responsibility for the survey and inform the Advice Centre of the contact details of the person <em>(immediately)</em></td>
<td>2.1</td>
</tr>
<tr>
<td>• Ensure staff lists are comprehensive and up to date <em>(immediately)</em></td>
<td>2.4</td>
</tr>
<tr>
<td>• Appoint a survey contractor to help with the survey implementation <em>(as soon as possible)</em></td>
<td>2.2</td>
</tr>
<tr>
<td>• Agree the precise division of labour between trust and contractor (e.g. who is responsible for sampling, printing, packing survey materials ready for distribution, taking receipt of completed questionnaires, monitoring response rates etc) <em>(as soon as possible)</em></td>
<td>2.2</td>
</tr>
<tr>
<td>• Decide on the precise content of the questionnaire (all trusts must include the Core questions) <em>(as soon as possible)</em></td>
<td>2.3</td>
</tr>
<tr>
<td>• Select staff sample, allocating a unique identification number to each selected member of staff <em>(as soon as possible)</em></td>
<td>2.5</td>
</tr>
<tr>
<td>• Arrange printing of the various survey documents - questionnaires, letters, reply-paid envelopes (each questionnaire to be printed or labelled with a unique staff identification number to help with monitoring response rates and targeting reminders) <em>(as soon as possible)</em></td>
<td>2.8</td>
</tr>
<tr>
<td>• Communicate with your staff. Arrange some internal publicity within the trust during October about the forthcoming survey <em>(prior to distribution of questionnaire)</em></td>
<td>2.6</td>
</tr>
<tr>
<td>• Inform the post room of the forthcoming questionnaire distribution and reminders <em>(prior to distribution of questionnaire)</em></td>
<td>2.6</td>
</tr>
<tr>
<td>• Arrange distribution of questionnaires to the selected sample via the internal post <em>(week commencing October 27th)</em></td>
<td>2.9</td>
</tr>
<tr>
<td>• Monitor response rates to this first mailing, and make use of the unique ID numbers on returned questionnaires to record which members of staff have not yet responded</td>
<td>2.9</td>
</tr>
<tr>
<td>• Two weeks after the initial mailing, arrange distribution of a reminder postcard to all staff who have not yet returned a questionnaire <em>(week commencing November 10th)</em></td>
<td>2.9</td>
</tr>
</tbody>
</table>

1 Or earlier date: see section 2.9
2.9 Monitor response rates to this second mailing, again identifying remaining non-responding staff

2.9 Two weeks after the reminder postcard, arrange distribution of a 2nd copy of the questionnaire to all non-responding staff, together with a reminder letter and another reply-paid envelope (week commencing November 24th)

2.10 Arrange for data from the completed questionnaires to be keyed or scanned, and to be transferred to the Advice Centre in the prescribed format (by December 19th)

2.1. Key survey contact within trust

At the start of the process, it is important to identify a key person within the trust who will take responsibility for the survey. This key person would be the main contact point for trust staff, the survey contractor (if applicable) and the Advice Centre.

If your trust has not already informed the Advice Centre of the name and contact details of this individual, it should do so at the earliest opportunity.

2.2. Approved Survey Contractors

We are strongly recommending that trusts appoint one of the seven Approved Survey Contractors to support them. These contractors have been fully vetted by CHI and have proved that they are able to provide a high quality service whilst offering value for money.

As a result, it is not necessary for trusts to conduct their own lengthy and costly individual tender exercises.

All seven Approved Contractors have been briefed in detail by the Advice Centre, and will be in close liaison with Advice Centre staff throughout the survey period. Furthermore, all Approved Contractors have contracts with CHI, under which they guarantee the provision of a high quality service.

The seven Approved Contractors are:

- Maritz
- MORI
- NHSP / PWR (capacity already full)
- Picker Institute Europe
- Quality Health
- RBA Research
- Taylor Nelson Sofres

Contact details for these seven organisations can be found in Appendix 7. More detailed information about them, including their quotations for providing the survey services can be found in the Service Level Agreement which has been sent to all trusts, and is available on the Advice Centre web site.

When using an Approved Contractor, trusts can select from a menu of services, including:
• Providing advice and support to trusts in selecting the staff sample
• Printing questionnaires, covering letters and reminders
• Packing up survey materials, ready for internal distribution by the trust
• Handling receipt of completed questionnaires, and liaising with trusts about non–responses and the distribution of reminders
• Providing support to ensure good response rates
• Data entry and transferring the cleaned data to the Advice Centre
• Analysis and reporting of findings (n.b. the Advice Centre will be providing each trust with a basic set of tables with the core question findings in Feb / Mar 2004)

The precise work to be carried out by the approved contractors will vary from trust to trust. While some trusts may choose to appoint a contractor to conduct the whole survey, others may wish to do some of the work themselves in order to keep costs down.

However, we strongly recommend that, as an absolute minimum, an approved contractor should be used to provide sampling support, to take receipt of the completed questionnaires and carry out the data entry. In this way, individual members of staff, worried about confidentiality, can be reassured that nobody in the trust will see their completed questionnaires. This has been shown to be important in the past, in order to achieve higher response rates.

Furthermore, compared to conducting an in-house survey, the use of an approved contractor can help to limit the burden on trust staff time. The amount of staff time needed to co-ordinate a large-scale survey is often under-estimated. In particular, organising the printing and packing of survey materials, the monitoring of response rates, targeting of reminder letters, and the data entry can be very time-consuming tasks, and can take trust staff away from their usual work.

Although we strongly recommend using an Approved Contractor, it is recognised that some trusts will conduct the survey in-house, or even use a non-approved contractor. If this is the case, it is vital that the instructions contained in the following pages are followed diligently by the trust/contractor. This is necessary to ensure all trusts are producing results that are comparable.

2.3. The Questionnaire

The next important step is to decide on the precise content of the questionnaire to be used in your staff survey. The questionnaire has three potential components, only one of which is compulsory:

• A set of Core (compulsory) questions, which must be asked in all trusts
• A set of Bank (optional) questions
• Local questions

All trusts must include the full set of Core questions in their questionnaire, but also have the option of selecting additional questions from an Optional Question Bank. It is hoped that the Core and Bank questions will cover all the key staff issues for the majority of trusts. However, trusts also have the option of including additional Local questions, to cover issues of particular local interest.

2.3.1. Core Questions
The Core questions cover:

- Work-life balance
- Appraisals & Personal Development Plans
- Training, Learning and Development
- Team Working
- Health and Safety
- Errors and Incidents
- Questions about respondents' jobs (including involvement in decision making, work pressure, job satisfaction and intention to leave)
- Management and Supervision
- Organisational Climate
- Harassment and Bullying
- Background Details.

Trusts will have already been sent a PDF file of the 12-side Core questionnaire, with an electronic copy of these guidance notes. This can be used by trusts that wish only to include the Core questions in their questionnaire. Unlike the compilation tool, which enables automatic insertion of the return address, there is an empty box on the front cover of the copy sent to trusts into which the return address should be entered before distribution. If your trust or PCT has not yet received these documents, please contact the Advice Centre as soon as possible.

2.3.2. Inclusion of Bank questions

The optional Bank questions cover:

- Length of time to travel to work
- Further issues on Training, Learning and Development (difficulties in obtaining training, protected time, benefits received from training, climate for training)
- Cleanliness, comfort and safety of the work environment
- Pay and conditions
- Directorate, division, department or location in which the employee works

These questions have been designed by the Advice Centre and, like the Core questions, have all been piloted successfully in NHS trusts. Documents containing the Core questions only, and the Bank questions only, are separately available on the Advice Centre website.

Please note that the precise wording of the Bank question about directorate / division / department will need to be amended to suit the local trust structure. The Compilation Tool enables you to insert the desired question and answer categories. There is space for up to 12 different categories.

An alternative to using this question for the purposes of directorate level analysis would be to use any information on directorate, division, department or location that was contained within the staff list used for sampling. This directorate analysis could be commissioned as an additional service from survey contractors.

2.3.3. Inclusion of Local questions

If there are additional staff issues which are very important locally, then it is up to trusts, and their appointed survey contractors, to design any additional Local questions. As far as possible, these local questions should be of a similar style to
that of the Core and Bank questions, to retain consistency within the questionnaire. These should be designed on separate pages, but then added to the pages of the PDF generated by the compilation tool, so that all questions can be printed within a single booklet.

Please note however, that according to the terms of the Ethical Approval granted by MREC North West Board for the National Staff Survey, trusts are required to submit any additional Local questions for approval by their Trust Management Board. (All Core and Optional Bank Questions are already fully ethically approved for use nationally, and do not need to be submitted for further approval in this way. For further details about ethical approval, see section 2.12).

2.3.4 Creating the questionnaire for your trust
Once it has been decided which questionnaire elements are required for use in the trust, the questionnaire can be generated using the Questionnaire Compilation Tool on the Advice Centre website (www.nhsstaffsurveys.com). A username and password (chosen by individual users) need to be entered, to enable identification of each questionnaire, allowing it to be saved and retrieved.

The Compilation Tool can be used to:
- specify the address to which completed questionnaires must be sent (e.g. address of the approved contractor)
- specify any additional telephone helpline number that the trust or contractor may have set up to answer staff queries
- select up to eight optional Bank questions for inclusion in the questionnaire

Once all the required elements have been selected, the questionnaire can be generated by the click of a button, “Generate PDF”. This produces the questionnaire in a PDF format, which can then be saved on the website, saved to disk, or printed. It is important to check the questionnaire contains the desired Bank questions, and that the instructions on the front cover (in particular return address and helpline number) have been generated correctly.

2.3.5 Length of the questionnaire
As mentioned earlier, the Core questionnaire is 12 A4 sides in length. Clearly, the inclusion of additional non-Core questions will increase the length of the questionnaire. (However, please note that the Core questionnaire has been designed so that there is room on the final page to include the Bank question about directorate / division / department, without increasing the number of pages).

It is recommended that, if further Optional Bank or Local questions are added, the questionnaire should be limited to a maximum of 16 A4 sides. A questionnaire that is longer than this will have an adverse effect on response rates.

2.4. Preparation of Staff Lists
One of the first steps towards conducting the staff survey is to compile a list of all staff that are eligible for the survey. This needs to be carried out by a member of trust staff, who is familiar with both the structure of staff records, and the computer programme Microsoft Excel.
This list should include:

- all full time and part-time staff who are directly employed by the trust on September 29th
- trust employees on all types of contract (permanent, fixed period, locum, temporary, seconded staff on trust payroll)

The list should exclude:

- all other staff employed by sub-contracted organisations or outside contractors
- bank staff (unless they are also trust employees as defined above)
- non-executive directors

Care should be taken to ensure that:

- no eligible staff members have been omitted from the list; (this could potentially happen if, for example, staff records are kept separately for different departments or sites within the trust)
- the list does not contain duplicate names
- records are up to date as of September 29th, including work address information

If HR provision is shared between multiple trusts, then it is important that staff lists are separated in such a way that a separate sample can be drawn for each trust, not one overall sample for the provision. The staff list for each trust should be consistent with the instructions above.

It is acknowledged that for some trusts, particularly PCTs, this process may cause particular problems. If there is any doubt about what needs to be done in a particular case, please contact the Advice Centre.

The staff list should be in Excel spreadsheet format, with one employee per row. The first row should be used for column headings (Name, Staff Group, Address etc.), and there should be no blank rows. Each employee should appear only once on the spreadsheet. For each employee, the spreadsheet should contain the following information:

- Full name
- Sufficient work address details (for internal distribution)
- Job title *
- Staff Group *
- Ward / Department / Speciality *

The work address details in the spreadsheet need to be sufficiently detailed to enable a questionnaire to be sent to each individual via the internal mail.

The asterisked information above is not absolutely essential, but would be extremely valuable both in monitoring response rates, and enabling trusts to carry out staff group or departmental analysis.

For further details of how staff lists should be formatted within Excel, see steps (a) to (c) of the instructions in section 2.5.3.
2.5. Selecting the Staff Sample

It is important that random sampling is used to select the Basic Sample. Random sampling provides a statistically valid way to gather data from a manageable portion of the population. It allows us to take results obtained in the sample and use them as our best estimate of what is true for the relevant population.

Once the staff list has been compiled in Excel, it will need to be passed to the survey contractor (if appropriate), or the person in your trust responsible for sampling, who will then take responsibility for drawing the staff sample.

All trusts and PCTs must select a random sample of employees, in accordance with the following detailed instructions. This sample is referred to as the Basic Sample throughout these instructions. The size of this Basic Sample will depend on the size of the trust, as explained below.

Some trusts may want to conduct the staff survey with a larger sample than is required, or conduct a Census within the trust. This is perfectly acceptable. However, please note that in such cases, it is still necessary to randomly select (and later be able to identify) the Basic Sample, according to the instructions below. It is only the data provided by this Basic Sample which will be fed back to the Advice Centre, and will be used by CHI and DH to develop national measures.

2.5.1. Determining the size of the Basic Sample

The size of the Basic Sample is determined by the number of employees in the trust eligible to receive a questionnaire (i.e. the number of people on the staff list identified in section 2.4). This varies in order to guarantee a similar degree of accuracy in the results for all trusts. The Basic Sample sizes are:

<table>
<thead>
<tr>
<th>Staff eligible to receive questionnaire</th>
<th>Basic Sample size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Under 750</td>
<td>Census</td>
</tr>
<tr>
<td>750-1000</td>
<td>600</td>
</tr>
<tr>
<td>1001-1500</td>
<td>700</td>
</tr>
<tr>
<td>1501-2000</td>
<td>750</td>
</tr>
<tr>
<td>2001-3000</td>
<td>800</td>
</tr>
<tr>
<td>Over 3000</td>
<td>850</td>
</tr>
</tbody>
</table>

2.5.2. Relative merits of surveying the Basic Sample alone, a larger sample, or a census

The advantages of conducting the survey among the Basic Sample alone are that it keeps costs to a minimum, and also limits the burden upon staff time. The minimum sample sizes have been designed to ensure that the survey findings will give a statistically representative picture of the views of all staff in the trust.

If trusts are considering surveying a larger staff sample or conducting a census, the advantages would include the possibility of more detailed sub-group analysis (e.g. by directorate or occupational group), and would give more staff the opportunity to give their opinions. However, the disadvantages are increased costs and increased burden on staff time.

n.b. If a trust surveys more than the Basic Sample, it is very important that the Basic Sample is still selected in the way described below, and that the full specified survey procedures are implemented. It should be remembered that only data from the Basic
Sample will be transferred to the Advice Centre, and it is only this data which will be used by CHI and DH to develop national measures.

### 2.5.3. Selecting a random sample of staff

The following steps give detailed instructions of how to draw a random sample using Excel. For further details about performing general tasks in Excel (such as deleting rows or columns) please see Appendix 5.

#### a) Row 1 to be used for column headings

The first row should be for column headings, such as “Name”, “Address”, “Site” etc.

#### b) One employee per row

Each subsequent row (beginning with row 2) should contain the details of one employee. Any blank rows, or rows containing other information (e.g. sub-headings) should be deleted. (See figure 1 for example.)

![Figure 1: An example of a data file ready for sampling](image)

#### c) Remove any irrelevant data

Delete any columns containing data irrelevant to the sampling, which will not be of any use later in the process (e.g. pay scale). However, please keep any information about job title, staff group or ward/department/speciality, as this will be very useful in analysing the survey findings, and will also enable organisations to detect any problems with the response rates of particular staff groups or departments during the survey period.

#### d) Insert a random number generator column
Go to the first blank column. Give it the heading “Random” by inserting this in the first row. This column will be the random number generator, necessary to do the sampling.

**e) Generate first random number**

In the second cell of the “Random” column (i.e. the row containing the details of the first employee) enter the text “= rand()” (without the quotation marks). Press Enter, and this should generate a random number between 0 and 1 (see figure 2).

![Random Number Generation](image)

**Figure 2: Generating random numbers**

**f) Repeat this random number generation for all cells in that column**

The simplest way to do this is to click on the first random number cell, then click on the small black square at the bottom-right corner of the cell. Then drag this down to the last row containing employee details. When the mouse is released, a random number between 0 and 1 is generated for each cell.

**g) Sort the data from lowest to highest random number**

Return to the top of the list. Highlight all columns by clicking and dragging across the column headers (either letters – A, B, C etc. – or numbers – 1, 2, 3 etc.). Then click on “Data” > “Sort”. Ensure “Header row” is selected. Then use the first drop down menu under “Sort by” to choose the row entitled “Random” (see figure 3). Click OK.
The data should now have sorted itself into a random order. The next stage is to select your staff sample. If there are to be $x$ employees in the survey, select the first $x + 1$ rows (including the column heading row), by dragging over rows 1 to $x + 1$.

Please note here:
- if you are only planning to survey the Basic Sample, $x$ will be the minimum sample size, as stipulated in section 2.5.1.
- if you are planning to conduct a survey with a larger sample of staff, then the $x$ referred to above should be this larger number
- if a census is desired, you should select all rows

Copy and paste this information (as appropriate) into a new worksheet. Delete the “Random” column from this new worksheet.

Each selected employee to be allocated a unique identification number
In the new worksheet containing only the selected employees, you now need to add ID numbers to the data. Choose the first blank column in the new worksheet. Give it the title “ID Number”. In the first cell of this column (beneath the column heading cell), enter the value “1”. Make a note of the location of this cell: for instance, if it is column F, row 2, the location is F2. If it is column 6, row 2, the location is R2C6.

Allocate consecutive ID numbers to each selected employee
In the cell below this, enter the text “= F2 + 1” (without the quotation marks), substituting for F2 if appropriate (see figure 4). This should generate the value “2” when you press enter. Click back on this cell, and click on the small black square at the bottom-right corner of the cell. When released, a sequence of ID numbers from 1 to $x + 1$ should be generated.
Figure 4: Assigning ID numbers

**k) Fix the ID number values, by replicating them in the next column**

This stage is very important to ensure that each selected employee is permanently linked to a unique ID number.

Highlight (select) all the ID numbers, along with the column heading. Click on “Edit” > “Copy”. Then click on the first cell to the right of this column (in the first row), and click “Edit” > “Paste Special”. Click on “Values” and “OK”. This will replicate the ID numbers. Delete the original column of ID numbers; these are liable to change if the file is re-sorted.

**l) Specify the Basic Sample**

The Basic Sample should consist of employees beginning with ID number 1. For instance, if the Basic Sample size is 750, the Basic Sample should comprise ID numbers 1 to 750. As it will be necessary to feed back an anonymised version of the Basic Sample file to the Advice Centre, it is necessary (either at this stage or later) to separate these individuals into a new worksheet. If the sampling procedure is carried out by the trust, but questionnaires are to be returned to a contractor, then an anonymised version of this file (i.e. with names removed) should be passed on to the contractor so that responses can be logged and sent to the Advice Centre.

**m) Quality checks on sampling procedure**

Before questionnaires are distributed, it is necessary to double-check that the Basic Sample has been selected and identified correctly. Please conduct the following checks on the sample:

- each member of the Basic Sample has an allocated ID number
- no ID numbers are duplicated
- the Basic Sample does not include any bank staff, staff working for external contractors, or non-executive directors
• the sample appears to be in a random order (i.e. it is not structured so that all occupational groups are together, or it is in alphabetical order)
• the proportion of staff in different staff groups or departments (where this information is available) appears appropriate for the trust – for example, if 50% of a trust’s employees are nurses, then approximately 50% of the sample should be nurses as well

n) Retention of staff list and Basic Sample
It is highly important, at this stage, to make sure the file has been saved. The Advice Centre will carry out some random checks on sampling procedures during October and November. Therefore, it is necessary to keep Excel files containing the original staff list, and the Basic Sample, in case they are requested by the Advice Centre, until the end of 2003.

o) Transfer of sampling information to the Advice Centre
The total number of staff eligible to receive the survey, and the size of the Basic Sample selected, should be e-mailed to the Advice Centre no later than October 31st. The name and contact details of the person responsible for the sampling in each trust should be included, in case the Advice Centre have any sampling queries later on.

2.6. Pre-survey communication with staff

It is important that trusts communicate with staff during October to inform them that the national survey is being launched on the 27th of October. Evidence shows that good communication can improve survey response rates, and help to counter the negative feelings experienced when staff feel over-surveyed.

The communications exercise should explain to all staff in your organisation:
• the purpose of the survey
• the ways in which survey findings can be used to improve staff's working lives
• how and when staff will be receiving a questionnaire
• how and when staff will get feedback on results

The Advice Centre will be providing reports to each trust in February / March 2004 with the results of their survey, together with national, regional and trust type benchmarks. Details of how staff can access this information should be provided (experience of previous studies has shown that staff morale diminishes if they have no feedback after taking the time to complete a questionnaire). However, trusts might choose to commission their contractor or in house analyst to produce a trust level survey report prior to the report that is provided by the Advice Centre.

The communication exercise also provides an opportunity to thank staff for taking part in the survey.

Examples of ready-made materials that can be used to publicise the forthcoming staff survey within trusts and PCTs are available to download from the Advice Centre website. These include briefing notes for managers, text that can be used in internal bulletins and team briefings, flyers that could be distributed with pay slips, and posters advertising the survey.
Communication can also take the form of publicising the outcomes of previous staff surveys. Staff are motivated to take part in surveys if they can see a tangible outcome from the findings, or if their views are acknowledged through trust communication. During the consultation for this project, trusts provided the Advice Centre with examples of new policy and practice that had been implemented from their past survey findings. These include: implementing diversity awareness policy; introducing a review on exit interview procedure; developing a new childcare policy; introducing a cyber café; obtaining local cut price sports facilities for staff and developing a new social scene club.

Please note that it is a requirement under the Data Protection Act 1998 that trusts inform staff that they are administering a survey.

2.6.1. The Post Room
Keeping the Post Room informed about the forthcoming survey is particularly important, as the staff there will play a crucial part in the internal distribution of questionnaires and reminders. Please see section 2.9 for further information about the survey distribution procedures.

2.7. Other ways of boosting response rates
The survey procedures detailed in these Guidance Notes have been designed as far as possible to maximise response rates: ensuring staff work addresses are up to date for internal questionnaire distribution; targeted reminders; mailing out 2nd copies of questionnaire to non-respondents; timely publicity of the forthcoming survey; good internal staff communication; use of approved contractors experienced in achieving high postal survey response rates.

However, we would also recommend the following ways in which trusts and Contractors can ensure a high survey participation rate:

- sending out a clear message that Trust Management supports the survey
- identifying "survey champions" within the trust, who can help with monitoring early response rates, and looking at ways during the survey period of encouraging response among low-responding staff groups and departments
- seeking to get local press coverage for the staff survey, to increase interest and awareness (CHI will be organising a press release about the National Survey in mid-October, so there should be some coverage in the national press)
- allowing staff to complete the questionnaire during working time

The overall target is to achieve a 60% response rate to the National Staff Survey, and it is hoped that most trusts will achieve this. However, it is also acknowledged that this is a transitional year, and several trusts may have conducted their own staff surveys less than a year ago, which may depress response rates in this first year.

While there will be no penalties for trusts not achieving a 60% response rate, it is very important that efforts are made to achieve as high a response rate as possible. Without this, the survey results cannot be said to be representative of the trust as a whole, and it will be these results that will be used by both CHI and DH to feed into national measures and ratings in 2004.

The results of your survey may be affected by a number of external events at either the national or local level. For example, your trust may have recently conducted its own local staff attitude survey. It is important to record any such events so that your
results can be interpreted in the light of such influences, and when year-on-year comparisons are made, external circumstances may be taken into account.

2.8. Printing of questionnaires, covering letters and reminder cards/letters

2.8.1. Questionnaires
The questionnaire compilation tool described in section 2.3 should be used to create a PDF document containing the Core and any Bank questions for a particular trust. Any Local questions should be designed on separate pages, and added to the end of the pages of the PDF document before printing to form a single document. The questionnaire has been designed in black, white and blue, and should therefore be printed in colour, rather than black and white. Experience has shown that the overall look of a questionnaire, including the use of colour, helps to raise survey response rates.

Questionnaires should be printed as A4 booklets (i.e. a 12-side questionnaire would be 3 folded A3 sheets, stapled in the centre).

All selected staff within a Trust should receive an identical questionnaire, in terms of content and format. The only difference between questionnaires distributed to different individuals should be in the ID number assigned during the sampling procedure (see section 2.5.3). There is an “Office Use Only” box on the front page of the questionnaire for this number to be printed or labelled.

2.8.2. Covering and reminder letters
There are three different types of letter / card, designed for use in the survey:

- a covering letter, which should accompany the questionnaires and a reply-paid envelope (which should be printed with the return address) in the first mailing
- a reminder postcard, to be sent to non-respondents two weeks later
- a reminder letter, which should accompany a 2nd copy of the questionnaire and another reply-paid envelope sent to non-respondents a further two weeks later

The text for these two letters and card has been prepared by the Advice Centre, and is downloadable from the Advice Centre website. The text is also given in Appendices 1 to 3.

The Advice Centre has obtained ethical approval for this text. If you make any substantial alterations to the text, you will need to seek the approval of your local Trust Management Board. However, the text allows the insertion of a return address and telephone number for which no additional approval is necessary.

Both letters and the postcard should be printed on paper / card, headed with the CHI logo. Trust logos can also be added to any letters if desired. The CHI logo and signature are being sent to trusts and Approved Contractors with the electronic copy of these guidance notes.

When calculating the number of questionnaires to be printed, you will need to allow for sending out second copies of the questionnaire with the 2nd reminder letters. Printing costs can be unnecessarily high if a second print-run is required, so it is worth ensuring that the first print-run is sufficiently large to allow for contingencies. As a rule of thumb, it is advisable to multiply the number of staff in the sample by 1.7
to obtain the number of questionnaires likely to be required. So, if the number of questionnaires you intend to send out is 850, then you might want to print 850 x 1.7, or approximately 1,500 copies.

It should also be noted that for each questionnaire that is printed, a first class reply-paid envelope should be printed also. These envelopes should be printed with the address to which questionnaires are to be returned.

2.8.3. Recycled paper requirements
It is a requirement that all paper used in the publication of the NHS staff surveys, including questionnaires and corresponding letters, must conform to government requirements for the use of 100% recycled paper with a minimum post-consumer waste content of 80%. It is further recommended that the paper used is uncoated and of standard A4 size.

2.9. Distribution and receipt of questionnaires, and prompting non-respondents
Survey documents should be distributed by trusts, using the internal post (or other internal distribution mechanisms). Survey contractors may be used to prepare the survey packs, each labelled with a unique ID number, ready for internal distribution by the trust.

The three survey distribution stages are summarised below:

- w/c October 27th\(^2\) - staff survey packs containing a questionnaire, covering letter and reply-paid envelope, to be distributed to all selected staff (each questionnaire marked with a unique identification number, in order to monitor response and target reminders)
- w/c November 10th\(^3\) - reminder post cards, to be distributed to selected staff who have not yet returned a questionnaire
- w/c November 24th\(^4\) - a 2\(^{nd}\) reminder letter, accompanied by second copies of the questionnaire and pre-paid return envelope, to be distributed to selected staff who have still not yet returned a questionnaire

Printing instructions for the various documents can be found in section 2.8.

As mentioned earlier, the Post Room will play a crucial part in the internal distribution of questionnaires and reminders. It is important therefore to inform the Post Room that their work load will increase over the survey period, and that they will be the heart of the questionnaire distribution centre. Our previous experience of distributing surveys has shown that it is useful to have the name of a key contact person in the Post Room, and that it is important to thank the Post Room staff for the extra work involved.

In particular, the Post Room should be warned in advance of the three distribution stages outlined above.

\(^2\) or earlier if, for example, some Trusts wish to distribute questionnaires with payslips
\(^3\) or two weeks after initial mailing
\(^4\) or four weeks after initial mailing
Please note: We would advise both trusts and survey contractors to monitor this distribution during the survey period. In past surveys, mailing out of the various survey packages has been delayed because Post Room staff were unsure of the distribution timetable.

2.9.1. Taking receipt of completed questionnaires

Each questionnaire should be marked with a return address to which staff should send their completed questionnaires. As mentioned earlier, we strongly recommend that questionnaires are returned to a survey contractor, rather than a trust. Having an independent organisation taking receipt of the questionnaires is reassuring to staff who maybe worried about the confidentiality of their responses. In this way, they can be reassured that nobody in the trust will see their completed questionnaires.

Whichever organisation is responsible for taking receipt of the completed questionnaires should log the return of each questionnaire according to its unique ID number.

At the end of the sampling process (section 2.5), an Excel file containing the names and ID numbers of the sample should have been saved. When a completed questionnaire for a particular ID number is returned, this should be noted on the Excel file by typing “C” in the cell immediately to the right of the ID number.

Please use the following codes to record the different types of staff response, against the appropriate ID numbers:

<table>
<thead>
<tr>
<th>Response code</th>
<th>Type of response</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Completed questionnaire returned</td>
</tr>
<tr>
<td>B</td>
<td>Blank questionnaire returned</td>
</tr>
<tr>
<td>REF</td>
<td>Staff member explicitly opted out / refused to take part</td>
</tr>
<tr>
<td>INEL</td>
<td>Staff member ineligible for survey (e.g. no longer working at the trust, or not directly employed by the trust)</td>
</tr>
<tr>
<td>N</td>
<td>Questionnaire not returned (reason not known)</td>
</tr>
</tbody>
</table>

For staff members who contact the trust or contractor to explicitly opt out of the study, or turn out to be ineligible for the survey, no more reminder cards or letters should be sent.

If a questionnaire is received in such a state that the ID number has been removed or made illegible, this questionnaire should not be included in data transferred to the Advice Centre. However, the occurrence should be noted, and the number of questionnaires returned without legible ID numbers should be reported to the Advice Centre with the response rates.
2.9.2. Monitoring response rates, and sending out reminders

This log of questionnaire returns against ID numbers will enable trusts and Contractors to monitor response rates during the survey period.

For example, it may become apparent, using this log, that a particular department has a very low response rate compared with others. If this is the case, it will be worth exploring the reason for that low rate. It might be that distribution in that department has not taken place as planned, or it may be necessary to further publicise and promote the survey within that department.

The log of questionnaire returns against ID numbers should also be used to target reminders at non-responding staff.

First reminder

Two weeks after the questionnaires are distributed, a reminder postcard needs to be sent to all staff who have not yet returned a questionnaire (i.e. those ID numbers for which no questionnaire has been logged).

Please do not send reminders to staff whose questionnaires have already been logged.

Second reminder

Two weeks after the reminder postcard mailing (four weeks after the initial questionnaire mailing), a further survey pack should be distributed to staff who have still not responded.

This survey pack should contain a reminder letter, a 2nd copy of the questionnaire (marked with each staff member's unique ID number) and a 2nd reply-paid envelope.

Please do not send survey packs to staff whose questionnaires have already been logged.

2.9.3. Informing the Advice Centre of ongoing response rates

Please keep the Advice Centre informed of progress with response rates during the survey period. If the Centre is made aware of problems with response rates at an early stage, Centre staff may be able to offer advice and help in raising the response.

Please therefore inform the Advice Centre of the Basic Sample response rate at these stages:

1) on the day that the reminder postcard is mailed out
2) on the day that the 2nd reminder letter & questionnaire are mailed out
3) at the end of the survey period, when the data is transferred

2.10. Data entry and data transfer to the Advice Centre

– instructions for the survey contractor or trust

The deadline for transfer of data to the Advice Centre is Friday 19th December.

This section gives information for trusts or contractors about how sample data, and data from returned questionnaires should be entered and transferred to the Advice Centre. It is the responsibility of the trust or contractor to enter data from returned
questionnaires into a given Microsoft Excel file, and then to return this data to the
Advice Centre at Aston University by 19th December.

If it is clear that there will be a delay in transferring the data to the Advice Centre,
please alert the Advice Centre at the earliest opportunity. However, in order to meet
the analysis and reporting requirements for CHI and trusts, we are reliant upon the
vast majority of trusts meeting the target deadlines.

The data to be returned by this date includes 2 files:
• The anonymised staff sample file (Excel), containing records of which staff have
  and have not returned questionnaires
• The questionnaire data file (Excel), containing data from returned questionnaires

In addition, the final response rate should be reported to the Advice Centre along
with this data. The response rate is defined as the proportion of questionnaires
distributed which are returned completed. However, the number and proportion of:
• blank questionnaires returned
• questionnaires returned without legible ID number
• staff members who explicitly opted out / refused to take part
• staff members who were reported as ineligible for survey should also be reported.

2.10.1. Staff Sample File
This is an Excel file compiled during the sampling and questionnaire receipt stages,
as described in sections 2.5 and 2.9. The file should only include members of the
Basic Sample, and should also include:
• ID number
• whether or not they returned a questionnaire (or were ineligible, or refused to
  take part) – recorded as described in section 2.9
• job title / staff group / department (or whatever information was available from the
  original staff records)

This file should be anonymised, i.e. staff names should be removed.

2.10.2. Questionnaire Data File
Data from returned questionnaires must be entered into a fixed, consistent electronic
format. It is important that the data is entered exactly as indicated in these
instructions; if there are discrepancies then it may lead to mistakes in the data
analysis.

The data returned to the Advice Centre should only include members of the Basic
Sample. It should also include only data from the Core questions, not Bank or Local
questions.

Method of data entry
A template for data entry is downloadable at www.nhsstaffsurveys.com. This
template is a Microsoft Excel worksheet, containing column headings for each
question on the questionnaire. The data from each questionnaire should then be
entered into a single row on these worksheets. (Note for contractors: data from
different trusts should be entered on separate worksheets.)
Data may be entered directly into these template worksheets, or may be copied from another worksheet. Although the template includes only Core questions, trusts and contractors may find it easier to enter the data into another worksheet in questionnaire order, and then transfer only the Core questions into the template.

Data should mostly be entered as numbers rather than words. The first column is for a Trust ID code, and should be used as follows:
- Contractors who are conducting the survey for multiple trusts should enter the three letter NHS code of the trust from which a questionnaire came
- Trusts who are conducting their survey in house may leave this blank

The ID number of the questionnaire should be entered in the second column. Codes to be entered for the different question options are printed in small type on the questionnaire, adjacent to the relevant tick-boxes. The only exceptions to this are:
- the very first question, where the number of hours worked should be entered as that number (correct to one decimal place, rounding up if necessary)
- a few questions where respondents have the option to write in an answer – a separate column is provided within the Excel file for this information to be entered
- the general comments box at the end, which should be entered into the final column as text.

There are some scenarios when questionnaires do not contain data in the expected format:
- Any questions left unanswered should be left blank in the Excel file.
- For questions requiring a single tick only, if respondents have ticked more than one response at those questions, the data should be treated as missing (i.e. left blank)

Data checking
It is important that the following data entry checks are carried out on the Basic Sample data in each trust:

- has the data been entered accurately? (this can be done by double-entering the data from a proportion of questionnaires, or directly comparing the hard-copies of the questionnaires to the entered data; if data is scanned, the latter check is also possible)
- has the data been entered in the right columns in the data entry worksheet? (it can be easy to enter the correct data, but in an incorrect column)
- for each question, have valid values been entered? (e.g. for a question with answer category values 1-5, check that there are no entered values outside this range)
- does the file for transfer to the Advice Centre contain all completed questionnaires from the Basic Sample? (checks should ensure that no data from a Basic Sample staff member have been excluded from the file; and also that all data from non-Basic Sample staff members have been excluded)

The Advice Centre will be conducting some random quality checks on data entry during the next few months. This means that some randomly selected specific questionnaires (identified by ID number) may be requested from trusts and
contractors, and these will be checked against the data provided. Therefore, it will be necessary to retain all hard copies of questionnaires until at least the end of February 2004.

**Data cleaning**

Trusts who are keying their own questionnaire data in-house should ignore this section, and skip to section 2.10.3.

The following instructions are for approved contractors, and for those scanning (rather than keying) their questionnaire data.

There are a number of filtered questions in the core questionnaire, and the following rules should be applied, when scanning or cleaning the data.

Sometimes, a member of staff may have given inconsistent responses to a set of filtered questions (e.g. the shift working question, which is Q7 in the Core questionnaire). For example, they may have said "No" to an initial filter question, but rather than following the instruction to skip onto a later question, they have answered the follow-up questions.

Taking the shift working question as an example, the following rules should be applied:

- If 7a is left blank, but there are answers given at 7b, 7a should be imputed as yes
- If 7a is given as “no”, but there are answers given at 7b, both questions should be set to missing (i.e. left blank)

These rules should be applied to all questions with filter instructions – shown in blue italics on the questionnaire.

2.10.3. *When the data has been entered*

Please save both Excel files named as the three-letter NHS code of the organisation from which the data came appended by “sample” or “data” respectively, so that it can easily be identified by the Advice Centre. For example, a trust with NHS code AAA would return files entitled “AAA sample.xls” and “AAA data.xls”. If contractors are returning data from multiple trusts in the same worksheet, it should be saved with the name of the contractor. To enable the Advice Centre to check that the correct code has been given to the correct trust, please also include the name of the trust(s) below the data in the Excel files.

All files should also be password protected, with the password being assigned by the trust or contractor and sent to the Advice Centre in a separate e-mail.

2.10.4. *Transferring the data*

Please send the data on a floppy disk, or CD, to:

NHS National Staff Survey Advice Centre,
ALMIR,
Main Building 252,
Aston Business School,
Aston University,
Aston Triangle,
Please also e-mail the data to the Advice Centre at c.m.hopkins@aston.ac.uk, with the overall response rate for the Basic Sample, total number of valid responses received (i.e. those from the Basic Sample with data entered), and the number of questionnaires checked and errors found, contained within the text of the e-mail. Contractors who are conducting surveys for many trusts may return the data in bulk, as long as:
- the total size of any e-mail is no more than 5MB
- both documents for any trust, and the response rate & data checking information for that trust, are contained within a single e-mail (although passwords should be given in a separate e-mail).

2.11. Reports of the survey findings

The Advice Centre will provide a report on the survey results for each trust. These will include frequencies of staff responses to all Core questions, summary scores for all scales, some breakdown of scores within trusts, and guidelines for interpretation of scores. All scores will be benchmarked against data for all trusts nationally and for similar types of trust. These benchmarked reports will be published on the Advice Centre web site during February 2004. A report on all national data will be published during April 2004.

Some trusts may want to commission additional analysis of their own data, or analysis of the trust level data before the Advice Centre reports are published. This must be negotiated separately with their survey contractors or data analysts.

Data for the Advice Centre reports will be weighted by subgroups to ensure trust results are comparable. The weightings used will depend on the average proportions for each group nationally. Therefore it is possible that results given in the reports would differ slightly from those given in reports from contractors, even if only the Basic Sample was analysed in those cases.

2.12. Ethical considerations

Aston University were awarded ethical approval for the development of the New National Staff Survey by the MREC North West Board.

Trusts are required through the 1998 Data Protection Act to inform their staff that they are being surveyed. Trusts are at liberty to choose the most appropriate forms of communication for their trust to enact this request.

Trusts are not required to submit any local questions through their local LREC board. However, they are required to submit local questions for approval through their Trust Management Board.

The Advice Centre is aware of the ethical implications of handling and storing sensitive data. Space has been allocated to ensure that data will be stored in locked accommodation. The data will be analysed on secure IT equipment that has strict password entry. The Advice Centre is ultimately responsible to Aston University for the handling of sensitive data.
Appendix 1

Covering letter to be sent to employees w/c October 27th (or earlier)

[Sections in blue are to be altered according to each trust’s/contractor’s needs]

Dear Colleague,

NHS National Staff Survey

We are writing to ask for your help with the first ever National NHS Staff Survey, which is being conducted by researchers from [insert name of survey company/name of trust], Aston University and the Commission for Health Improvement (CHI). [Your name was selected at random from a list of all staff working for your trust.]

The survey asks your views about work and the health care organisation for which you work. The aim of the survey is to help the NHS to provide better care for patients and improve the working lives of staff. Your employer will be able to use the survey to inform improvements in working conditions and practices at a local level. CHI will use the survey findings in their reviews of the NHS, and to develop performance indicators which will form the basis of NHS star ratings in 2004. The survey results will also enable the Department of Health to assess the effectiveness of national NHS staff policies (such as training and flexible working policies) and to inform future developments in this area.

Your participation in the survey is entirely voluntary. However, by completing the questionnaire, you will provide valuable information which will be used to improve NHS working practices and patient care. The results of this survey will only be truly representative if all selected staff complete and return the questionnaire.

Your answers will be treated in confidence. No one outside the research team will be able to know which individual gave which answers. The anonymous survey findings will be analysed by Aston University and CHI, and the results will be presented in a form in which no individual's answers can be identified.

We very much hope you agree to take part, and would be grateful if you could return your completed questionnaire, to [insert return address].

If you have any questions or comments about this survey, you can find out more by logging onto the Staff Survey Advice Centre web site (www.nhsstaffsurveys.com), or by calling the Survey Helpline on 0121 359 2491 (available 10-4 on weekdays) [if contractor or trust helpline is available, insert detail here].

Many thanks for your help with this important survey.

Yours sincerely,

Matt Tee
Director of The Office for Information and Health Care Performance
Appendix 2

Reminder postcard to be sent 2 weeks after original questionnaire

Dear Colleague,

NHS National Staff Survey

About two weeks ago we sent you a questionnaire seeking your opinions about working in the NHS. [Your name was randomly selected from a list of all staff working for your NHS trust.]

If you have already completed and returned the questionnaire, please accept our sincere thanks, and we apologise for this reminder.

If you have not yet completed the questionnaire, please do so today and return it to [insert address here]. It is only by hearing the views of as many staff as possible, that we can assess the success or otherwise of NHS working practices and policies.

Many thanks for your participation.

Yours sincerely,

Matt Tee
Director of The Office for Information and Health Care Performance
Appendix 3

Reminder letter to be sent two weeks after first reminder

Dear Colleague,

NHS National Staff Survey

About four weeks ago, we sent you a questionnaire asking about your experiences of working in the NHS. Many staff have already completed and returned this questionnaire, and if you have done so, please accept our sincere thanks.

This is the first national survey of NHS staff and the results will be extremely valuable to CHI, the Department of Health and your local trust, for improving patient care and the working lives of staff.

If you have not yet returned your questionnaire, we are writing again because of the importance that your questionnaire has for helping to get accurate results. Although we sent questionnaires to a wide range of staff in the trust, it is only by hearing from everyone in the sample that we can be sure that results are truly representative. We have enclosed another questionnaire in case you have misplaced the original one.

We would like to reassure you that information released to the trust will be in a form that protects individuals’ anonymity, and any report of the trust survey will be written in summary form, in which no individual's answers can be identified.

Many thanks in anticipation of your help.

Yours sincerely,

Matt Tee
Director of The Office for Information and Health Care Performance
# Appendix 4

## Summary of files/information to be transferred to the Advice Centre

<table>
<thead>
<tr>
<th>Document/Information</th>
<th>How returned</th>
<th>By when</th>
<th>By whom</th>
<th>Where in guidance notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name/contact details of person responsible for the survey in the trust</td>
<td>Form already posted to HR directors, or e-mail</td>
<td>As soon as possible</td>
<td>Trust</td>
<td>Section 2.1</td>
</tr>
<tr>
<td>Number of staff in trust eligible to receive questionnaire; size of Basic Sample</td>
<td>E-mail</td>
<td>By October 31&lt;sup&gt;st&lt;/sup&gt;</td>
<td>Trust or contractor</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Name and contact details of person responsible for sampling</td>
<td>E-mail</td>
<td>By October 31&lt;sup&gt;st&lt;/sup&gt;</td>
<td>Trust or contractor</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Response rates at time of sending first reminder</td>
<td>E-mail</td>
<td>When first reminder is sent</td>
<td>Trust or contractor</td>
<td>Section 2.9</td>
</tr>
<tr>
<td>Response rates at time of sending second reminder</td>
<td>E-mail</td>
<td>When second reminder is sent</td>
<td>Trust or contractor</td>
<td>Section 2.9</td>
</tr>
<tr>
<td>Data documents (Staff sample file, Questionnaire data file)</td>
<td>By post, and as attachment to e-mail</td>
<td>By December 19&lt;sup&gt;th&lt;/sup&gt;</td>
<td>Trust or contractor</td>
<td>Section 2.10</td>
</tr>
<tr>
<td>Other information – final response rate &amp; number of completed questionnaires received, number of questionnaires checked, number of errors found, password for data files</td>
<td>E-mail</td>
<td>By December 19&lt;sup&gt;th&lt;/sup&gt;</td>
<td>Trust or contractor</td>
<td>Section 2.10</td>
</tr>
<tr>
<td>Questionnaires for data checking</td>
<td>By post (recorded delivery)</td>
<td>On request from Advice Centre</td>
<td>Trust or contractor</td>
<td>Section 2.10</td>
</tr>
<tr>
<td>Staff list and sample</td>
<td>Attachment to e-mail</td>
<td>On request from Advice Centre</td>
<td>Trust or contractor</td>
<td>Section 2.5</td>
</tr>
</tbody>
</table>
Appendix 5

Detail of how to perform some procedures in Excel

(a) Inserting a blank first row
Click on the top, left hand cell (usually ‘A1’ or ‘R1C1’) and then “Insert” > “Rows”. This should insert a blank row, which can be used for headings.

(b) Deleting rows
To delete a row, highlight it by clicking on the row number at the extreme left-hand end of the row, and click on “Edit” > “Delete”.

(c) Deleting columns
Deleting a column is done in the same way as deleting rows (see b).

(d) Selecting multiple rows
Place the mouse pointer over the row number of the first row you wish to select (on the far left hand side of the worksheet). Click and drag down to the row number of the last row you wish to select. When the mouse is released, these rows should then be highlighted.

(e) Copying and pasting multiple rows into a new worksheet
When rows are selected, click on “Edit” > “Copy”. Open a new worksheet by clicking “File” > “New”. Paste in the rows by clicking “Edit” > “Paste”.

(f) Changing the cell reference style from ‘R1C1’ to ‘A1’
Some operations are easier to carry out with the ‘A1’ style of cell reference, rather than the ‘R1C1’. To change this, click on “Tools” > “Options”, then the “General” tab, and uncheck “R1C1 reference style”.

(g) Password protecting files
To make sure that a file can only be accessed by someone who knows a password, click on “File” > “Save As”. Then click on “Tools” > “General Options”. Enter a password which will protect the file before saving it.
Appendix 6

Development of the survey

Consultation
Researchers consulted widely with more than 400 people from ten trusts (Acute/ PCT/ Speciality/ Strategic Health Authority), including staff side representatives, frontline staff, black and minority ethnic groups and managers, in order to design a questionnaire that is both user friendly and will serve to Improve Working Lives.

The issues covered in the pilot questionnaire included team working, clear responsibilities, access to and experience of a range of training and development opportunities, working hours, work life balance, job satisfaction, pay, incident reporting, managerial support, communication within the organisation, health and safety, bullying and harassment, violence, quality of patient care, and diversity within the workforce.

All of the core and optional questions were conducted in the pilot study. Subsequently, they have been analysed to select which are core questions and which are optional questions for year 2003. Further consultation will take place during 2004 to develop questions for survey 2004.

Pilot survey
Five trusts took part in the pilot study: two acute trusts, one mental health trust, one primary care trust, one ambulance trust. The approved pilot contractor conducted the survey in four of the trusts and the Advice Centre conducted the survey in the Ambulance trust.

The purpose of the pilot was both to test the questions, and to uncover any difficulties that pilot sites encountered with the survey procedures, including sampling, questionnaire distribution and data entry.

The findings from the pilot study were used to inform decisions about:-
- the final design of the questionnaire
- the best methods of providing advice and support to trusts and contractors
- the most effective ways of achieving high survey response rates (through use of pre-survey communication within the trust, reminders to non-responding staff members etc);
- the most useful format in which to feed back survey results to trusts, so that they can be used to directly influence the management of working lives, and the delivery of patient care
Appendix 7
Contact Details of Approved Contractors

Maritz
Contact: Neil Barber
Telephone: 01628 895305
e-mail: nbarber@maritz.co.uk
Maximum survey capacity: 50 trusts

MORI
Contact: Tim Jennings
Telephone: 0207 3473000
e-mail: tim.jennings@mori.com
Maximum survey capacity: 200+ trusts

NHSP/PWR (capacity already full)
Contact: Cheryl Kershaw
Telephone: 01423 720212
e-mail: cheryl@payandwork.co.uk
Maximum survey capacity: 125 trusts

Picker Institute Europe
Contact: Nick Richards
Telephone: 01865 208100
e-mail: nick.richards@pickereurope.ac.uk
Maximum survey capacity: 200+ Trusts

Quality Health
Contact: Reg Race
Telephone: 01246 856263
e-mail: qhconsult@aol.com
Maximum survey capacity: 100 trusts

RBA Research
Contact: Kevin Simmonds/Andrea Nove
Telephone: 0113 2856300
e-mail: service@rba-research.co.uk
Maximum survey capacity: 30-50 Trusts

Taylor Nelson Sofres
Contact: Gillian Prior
Telephone: 0208 967 4259
email: gillian.prior@tns-global.com
Maximum survey capacity: 50 trusts

More detailed information about the Approved Contractors, including their quotations for providing the survey services can be found in the Service Level Agreement which has been sent to all trusts, and is available on the Advice Centre web site.